
                                                                                                                                                                                                                                  

                                                                                                           instrumentation and software for research 

 

 

 

 

 

 

TAIL SUSPENSION 
SOF-821 

USER’S MANUAL 

 

 

 

 

 

 

 

 

DOC-006 
Rev. 1.2 
 
Copyright ©2012 
All Rights Reserved 

 

 

 

Med Associates Inc. 
P.O. Box 319 
St. Albans, Vermont 05478 

 

Phone: 802.527.2343 
Fax: 802.527.5095 
www.med-associates.com  

 



 SOF-821, TAIL SUSPENSION 

 

i 

 

 

 

 

 

 

 

 

 

 

notes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  



 SOF-821, TAIL SUSPENSION 

 

ii 

 

Table of Contents 

Chapter 1 | Introduction ................................................................................................ 1 

Chapter 2 | Tail Suspension Hardware ....................................................................... 2 

General Computer Environment.................................................................................................. 2 

Backing Up Software .................................................................................................................... 2 

Driver Installation .......................................................................................................................... 3 

Software Installation ..................................................................................................................... 4 

Wiring Guide .................................................................................................................................. 7 

Chapter 3 | The Tail Suspension Software ............................................................... 10 

Starting and Using the Tail Suspension Software .................................................................. 10 

Dependent Variables ................................................................................................................... 10 

Menu Options ............................................................................................................................... 10 

Hardware Setup ........................................................................................................................... 12 

Calibrate ....................................................................................................................................... 13 

Experiment Setup ........................................................................................................................ 15 

Chapter 4 | Starting an Experiment .......................................................................... 18 

Chapter 5 | Using Tail Suspension Viewer ............................................................... 21 

Opening a File to View ............................................................................................................... 21 

Menu Options ............................................................................................................................... 22 

The Trace 1 Line ......................................................................................................................... 23 

Trace 2 Line (Tracking Line) ..................................................................................................... 24 

Zoom ............................................................................................................................................. 24 

Viewing Multiple Chambers........................................................................................................ 24 

Replaying the Experiment .......................................................................................................... 25 

Closing the Raw Data File .......................................................................................................... 25 

Chapter 6 | Viewing Experiment Summary Information ...................................... 26 

Appendix A | DIG-735 .................................................................................................. 27 

DIG-735 DIP Switch Settings .................................................................................................... 27 

The Integration Switch ............................................................................................................... 27 

The High-Pass Filter .................................................................................................................... 28 



 SOF-821, TAIL SUSPENSION 

 

iii 

 

Appendix B | Data File Formats .................................................................................. 29 

Summary File ............................................................................................................................... 29 

CSV (Comma Separated Value) summary data files .............................................................. 30 

CSV (Comma Separated Value) batch summary files ............................................................ 30 

CSV (Comma Separated Value) Files ....................................................................................... 30 

Appendix C | Contact Information ............................................................................. 30 

 



MED ASSOCI ATES  I NC.   SO F-8 21,  T AIL  SUSPE NSIO N  

- 1 -  

DOC-006 Rev 1.2 Copyright © 2012 

MED Associates, Inc. 

CHAPTER 1  | INTRODUCTION 

The Tail Suspension test is a technique that is typically utilized to study the effects of 

antidepressants on mouse behavior.  The primary dependent measure is the time to relative 

immobility; therefore, the duration and vigor of activity is inferred to be an index of escape 

persistence.  

The MED Associates’ Tail Suspension Hardware uses a load cell to measure activity, and the load 

cell interfaces with the Tail Suspension Software via a PC to represent the activity as a voltage 

output.  The Tail Suspension software captures and records the voltage output as both 

quantitative and graphic data.  Please read through this manual carefully before executing an 

experiment. 

MED Associates, Inc., is committed to providing the scientific community with reliable and 

innovative behavioral-research tools.  Please send comments/inquiries to sales@med-

associates.com.  Thank you for purchasing the Tail Suspension Hardware and Tail Suspension 

Software.  MED Associates, Inc., looks forward to meeting your immediate and future research 

needs.

mailto:sales@med-associates.com
mailto:sales@med-associates.com
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CHAPTER 2  | TAIL SUSPENSION HARDWARE 

General  Computer Environment  

The minimum recommended system is as follows:  

 A 1.2 GHz or higher computer with at least two available PCI slots  

 Windows 2000 or XP 

 512 MB of RAM 

 2+ Gigabytes of free disk space 

 CD-ROM drive 

 Keyboard & mouse 

 

NOTE: Do not run any other software programs concurrently with the Tail Suspension 

Software, as this may impede data acquisition.   

Backing Up Software  

It is strongly advised that a backup copy of any data files created by Tail Suspension be 

created.  By default Tail Suspension stores its data in the My Documents\Tail Suspension 

directory. 
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Driver Instal lation  

If a complete system was purchased from MED Associates, including a PC, the DIG-744 

card, DIG-729 card, and the Tail Suspension software have already been installed.  The 

PC is already configured with these accessories.  Please skip ahead to Wiring Guide 

section of this manual. 

Insert the Tail Suspension CD into the CD-ROM drive, and the installation screen shown in Figure 

1 should appear automatically.  If it does not appear, go to “My Computer”, click on the “Tail 

Suspension” CD, and double-click the “autorun.exe” file.   

 

Figure 1 - Tail Suspension CD Menu 

 

 

Click To install the DIG744 card (NI-DAQ) and driver click here.  Follow the instructions shown 

on the screen, then shutdown the computer and install the DIG-744 card according to the 

directions for installing PCI cards included with the computer.  At this time also install the DIG-

729PCI card.  Be sure that power to the computer is off before installing or removing any PCI 

cards.   

Once the DIG-744 (NI-DAQ) driver and PCI card have been installed, turn the computer back on 

and run the “Measurement & Automation” program found on the desktop.  Under “Devices and 

Interfaces”, the PCI-6023E (DIG-744) card should be visible.  Click on the PCI-6023E card then 

click the Properties button.  Click on the AI tab and set the Mode to Referenced Single Ended, as 

shown below. 
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Figure 2 - Configuring the Device 

 

 

Click OK and run the Test Panel to verify that the card is working correctly, then close the 

“Measurement & Automation” program.   

Once this is done, open “My Computer”, and open the CD drive that contains the Tail 

Suspension software (SOF-821) CD.  From the screen shown in Figure 1, click To install 

the DIG729 device click here, and follow the instructions for installing the DIG729 

driver.   

Software Instal lation  

Now that both of the drivers have been installed, open the CD drive that contains the Tail 

Suspension software (SOF-821) CD again and click To install Tail Suspension click 

here to install Tail Suspension software.  The screen shown in Figure 3 will appear.   

 

Figure 3 – Tail Suspension Installation  
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Click Next to continue with the installation process.  The screen shown in Figure 4 will 

appear. 

 

Figure 4 – Customer Information 

 

 

Enter the necessary User Name, Organization and Password.  The Tail Suspension password is 

provided by MED Associates when the software is registered.  Click Next when all of the fields 

are completed.  The screen shown in Figure 5 will appear. 

 

Figure 5 – Destination Folder 

 

 

If the destination folder shown is correct, click Next to proceed.  If the destination folder should 

be changed, click Change… and browse to the desired destination. 
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Figure 6 – Setup Type 

 

 

Select the Setup Type and click Next.  The screen shown in Figure 7 will appear. 

 

Figure 7 – Review Installation Settings 

 

 

Review the information shown and if everything is correct, click Install.  If any of the installation 

settings must be changed, click Back. 
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Figure 8 – Installation Complete 

 

 

The Tail Suspension software installation process is now complete.  Click Finish to close this 

screen. 

Wiring Guide 

 

Figure 9 - Computer Cable Connections (Actual Location of the PCI cards may vary depending on 

computer configuration)  
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Figure 10 - Tail Suspension Interface Cabinet  

 

 

Figure 11 - ENV-505TS Load Cell Amplifier  

 

 

Figure 12 - Front and Rear Views of the PHM-300 Tail Suspension Chamber  
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1. Connect the DIG-729 card (located in the computer) to the DIG-735J card (located in 

the interface cabinet) using the SG-219C-10 control cable.   

2. Connect SG-244A adapter to the DIG-744 card (located in the computer). 

3. Connect DIG-735J card (located in the interface cabinet) to the SG-244A adapter 

using the SG-219TS cable. 

4. Connect the cable from the load cell in the PHM-300 Tail Suspension chamber to the 

ENV-505TS Load Cell Amplifier using the 6-pin Molex connector.   

5. The DIG-735 card in the interface cabinet connects to the ENV-505TS Load Cell 

Amplifier using the SG-219F1 cable, which terminates with a 4-pin Molex connector. 

 

NOTE: Notice that the PHM-300 chambers and the DIG-735 cards are numbered.  Be 

sure to connect each PHM-300 chamber to the corresponding DIG-735 card. 
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CHAPTER 3  | THE TAIL SUSPENSION SOFTWARE 

Starting and Using the Tai l  Suspension Software  

Start the Tail Suspension software by double clicking on the MED Associates “Tail 

Suspension” shortcut on the desktop. 

Dependent Variables  

Along with saving raw data, the Tail Suspension Software saves and calculates the following 

parameters: 

Elapsed Time – The duration of time that the chamber has run. 

Time Below Lower Threshold – The amount of time that activity, measured in voltage, was 

below the lowest threshold. 

Time Above Lower Threshold – The amount of time that activity, measured in voltage, was at or 

above the lowest threshold but less than the uppermost threshold. 

Time Above Upper Threshold – The amount of time that activity, measured in voltage, was at or 

above the uppermost threshold. 

Lower Threshold Crossings – The number of times in which the activity data were below the 

lower threshold then became greater than or equal to the lower threshold. 

Upper Threshold Crossings – The number of times in which the activity data were below the 

upper threshold then became greater than or equal to the upper threshold. 

Sum Above Lower Threshold – The sum of the activity data when the data were less than the 

upper threshold and greater than or equal to the lower threshold. 

Sum Above Upper Threshold – The sum of the data when the data were greater than or equal 

to the upper threshold. 

Menu Options  

The following options are available under the File menu. 

 Preferences – Sets general hardware and software preferences for threshold, including the 

number of chambers and the data acquisition resolution. 

 Calibrate – Calibrates the inputs for each chamber. 

 Exit – Exits the Threshold program. 

The following options are available under the Experiment menu. 

 Start Experiment – Displays the experiment form and allows the experiment to be started. 

 Start Chambers – Starts chambers that are currently configured. 

 Stop Chambers – Stops chambers that are currently running and saves data. 

 Abort Chambers – Abort chambers that are currently running without saving data. 

 Pause Chambers – Pause chambers that are currently running. 
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 Resume Chambers – Resume chambers that are currently paused. 

The following options are available under the View menu. 

NOTE:  CSV (Comma-Separated Value) file format is a common spreadsheet format that can be 

viewed using any spreadsheet application. 

 View Text Summary File – Displays summary files. 

 View CSV Summary File – Displays CSV summary files. 

 View CSV Batch Summary File – Displays CSV batch summary files. 

 View Raw Data File – Displays raw data files. 

 View CSV Raw Data File – Displays CSV raw data files. 

The following options are available under the Create menu. 

 Create Text Summary File – Creates a text summary file from a raw data file. 

 Create CSV Summary File – Creates a CSV summary file from a raw data file. 

 Create CSV Batch Summary File – Creates a CSV batch summary file from a set of raw 

data files. 

 Create CSV Raw Data File – Creates a CSV raw data file from a raw data file. 

The Color menu allows the color of selected items in the Threshold software window to be 

changed. 

 Input – Changes the color of the load cell trace. 

 Upper Threshold – Changes the color of the upper threshold line. 

 Lower Threshold – Changes the color of the lower threshold line. 

The Window menu provides several different ways in which to view multiple tail-suspension 

chambers simultaneously.  
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Hardware Setup 

To set up the hardware select File | Preferences. Refer to Figure 13. 

 

Figure 13 – Preferences Screen 

 

 

Number of Chambers – Sets the number of chambers in the Tail Suspension system.  Select any 

number between 1 through 8, depending on the number of PHM-300 Tail Suspension chambers 

in the system. 

Resolution – Sets the data acquisition rate, in milliseconds per sample.  This number can be 

between 1 and 500 milliseconds, with 10 milliseconds being the default. 

Save Text Summary Files – When checked saves a text summary file of the experiment.  This is 

the original data file format. 

Save CSV Summary Files – When checked saves a CSV (Comma Separated Value, or spreadsheet 

format) version of the text summary file. 

Save CSV Batch Summary Files – When checked saves a CSV batch summary file.  A batch 

summary file is a single data file that contains the results of multiple experiments.  This is the 

most useful data file when experiments contain a limited number of data blocks. 

Save CSV Raw Data Files – When checked, automatically converts the raw data file to a 

spreadsheet file when the experiment is complete.  Spreadsheet files may be very large, so use 

caution when using this setting.  By default this setting is turned off as raw data files can be 

converted to spreadsheet files at any time, by going to Create | Create CSV Raw Data File. 
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Automatic File Naming – When checked, automatically names the data files based on 

experiment, group, and subject.  If not selected, a file name must be entered manually for each 

chamber in the Experiment Settings dialog. 

Browse (Data Directory) – Sets the directory where all data files are stored. 

Data Subdirectory Options – When set to By Experiment, automatically creates a subdirectory 

for each experiment, and all data files are saved into the appropriate experiment directory.  

When set to By Month_Year, automatically creates a subdirectory for each month, and all data 

files are saved into the appropriate month directory.  When set to By Month_Day_Year, a 

subdirectory is created for each day.  When set to None, no subdirectories are created and all 

data files are saved into the data directory. 

NI-DAQ Device Number – Sets the number of the NI-DAQ device (DIG-744 PCI card) to use.  The 

device number is listed in the Measurement and Automation program; typically this number is 

set to 1. 

Consolidate files to a single spreadsheet file – Exports one spreadsheet file for all chambers 

that is compatible with version 1 of Tail Suspension software.  

Calibrate 

Go to File | Calibrate to calibrate the Tail-Suspension Load-Cell Amplifier. The 

calibration screen will appear (Figure 14). The Load-Cell Amplifier translates movement, 

or more specifically “displacement,” into a voltage signal that is then read by the Tail 

Suspension Software.  

Calibrate the Load-Cell Amplifier for each chamber when the equipment originally arrives 

from the manufacturer, and occasional throughout use, to ensure proper measurement of 

mobility.   

 

Figure 14 – Calibration Screen 

 

 

The Calibration screen provides information on the experimental parameters in real time.  

The Upper and Lower Thresholds may be adjusted by click ing the up and down arrows on 

the sides of the boxes.   

Change the Gain by clicking on the drop down arrow on the side of the Gain box. The 

number in the Value box is the value of the last data point on the screen.   



MED ASSOCI ATES  I NC.   SO F-8 21,  T AIL  SUSPE NSIO N  

- 14 -  

DOC-006 Rev 1.2 Copyright © 2012 

MED Associates, Inc. 

To calibrate the system: 

 Set the Gain to “1” and the coupling mode to “DC” (see Figure 15).  

 Set the TEST/RUN switch on the ENV-505TS to the RUN position and the 

0g/40g switch to the 40g position. 

 Adjust the tare control for the load cell (on the ENV-505TS) with a small 

screwdriver until the plot value is as close to zero as possible, but not less than 

zero.  

 

Figure 15 - Adjusting the Tare Control for the Load Cell  

 

 

 Increase the Gain to 16, and adjust the tare control again so the plot value is as 

close to zero as possible, but not less than zero. 

 Switch the Gain back to 1 and the plot line should disappear into the 0 line.  

 Set the TEST/RUN switch on theENV-505TS to the TEST position.  The display 

should indicate an 80% (40g) reading.  Return the 0g/40g switch on the ENV-

505TS to the 0g position and the display should again read 0 (Figure 16).  

 

Figure 16 - 0g / 40g TEST Pulses As Seen in the Calibration Window  

 

 

 Set the coupling mode to AC and the 0g/40g switch to 40g.  A 40g impulse 

response that will return to 0g, due to the AC coupling should be seen.  
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Figure 17 - 40g AC Pulse 

 

 

 Set the TEST/RUN switch back to RUN and leave the 0g/40g at 40g and 

calibration is finished. 

“Calibration” is a diagnostic procedure intended to verify the functionality of the ENV-

505TS Load-Cell Amplifier.  Calibration cannot verify the functionality of the Load Cell 

itself.  To do this, suspend a known weight (1g-50g) from the hanger with the calibration 

in DC Mode and observe the displayed value. If the displayed value across multiple 

chambers differs using the same weight, and the instruction for Load-Cell Amplifier 

calibration have been followed, contact customer support at MED Associates at 

support@med-associates.com. 

Experiment Setup 

To define experiment settings, go to Experiment | Start Experiment (Figure 18).  

Experiment settings can be saved and used to define future experiments, thus saving set -

up time.  

 

Figure 18 – Experiment Settings Screen 
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Modify the Experiment ID field by selecting the Add Experiment button in the lower 

right-hand portion of the screen.  Enter an experiment title (see Figure 2.8), and click 

OK to save this Experiment ID.  All Experiment IDs are automatically saved for future 

use. 

 

Figure 19 - Add Experiment Window  

 

 

Select the Modify Experiment button in the lower right-hand portion of the Experiment 

Setting screen to change the experiment time and threshold settings (Figure 2.9).  

 

Figure 20 - Modify Experiment Screen  

 

 

Enter the length of the experiment in the Experiment Time box.  The time may be 

specified in seconds or minutes. 

Block Time sets the duration of user-defined “block” intervals within the session. Use 

Block Time to divide the session into components that can be statistically analyzed at a 

later date. The total number of blocks that will be written to the summary file is 

displayed in the Number of Blocks box. 

The Start Trigger feature will automatically start the experiment when activity 

measured by the load cell meets or exceeds the Start Trigger  value. This feature will is 

useful to start data capture when an experimental subject is attached to the load -cell 

hook. If it is not desire to use this feature, enter zero in the Start Trigger box, otherwise 

enter the desired value.  
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Enter the desired Threshold values in the Upper and Lower Threshold boxes.  There are three 

time counters.  The first one measures the amount of time that is spent below the Lower 

Threshold.  The second one measures the amount of time spent above the Lower Threshold, but 

below the Upper Threshold.  And the last one measures the amount of time spent above the 

Upper Threshold.  Most researchers using Tail Suspension are interested in immobility, defined 

using only the Lower Threshold; therefore, set this threshold at a level that differentiates the 

definition of immobility from mobility. If desired, the Upper Threshold may also be used to 

distinguish moderate immobility with greater level of activity. If this is not desired, we 

recommend setting the Upper Threshold to 100.  

Select the desired Gain value to adjust the load cell appropriate to the average subject’s 

weight.  This setting will amplify the signal by the Gain value.   

Select OK on the Modify Experiment screen to return to the Experiment Settings screen. 

Enter the information for Group and Subject ID, and add any Subject Info or 

Comments to be saved in the data file.  If utilizing more than one tail -suspension 

chamber, select Copy data to all chambers. This option will save Experiment ID and 

Group ID to all chambers, but Subject ID and other subject-specific information will need 

to be entered per chamber. 
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CHAPTER 4  | STARTING AN EXPERIMENT 

When all modifications have been made to the Experiment Set tings, begin the session by 

pressing the Start Experiment button.  The Select Chamber to Start screen will 

appear (Figure 21). 

 

Figure 21 – Select Chamber to Start  

 

 

Click on the Select All Chambers button to select all the chambers or click on the box 

to the left of the chamber number to select individual chambers.  After the desired 

chambers have been selected, click on the Start button; this will start data acquisition 

for the selected chambers.   
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Figure 22 – Experiment Running Screen 

 

 

Figure 22 shows what the Tail Suspension software screen may look like during an 

experiment with 8 chambers running.  Figure 23 is an expanded view of the data that will 

be displayed for each chamber as an experiment is  running. 

 

Figure 23 - Experiment Running Screen, Close-Up of Numeric Data  

 

 

The Elapsed Time is how long the experimental session has been running.  The Below, 

and Above refer to the amount of time spent below and above each Threshold for the 

current Block (see Number of Blocks and Block Time sections of this manual). 

Crossings represents the number of times the plot crossed above and then below Lower 

Threshold or Upper Threshold for the current Block.  Sum Above is the total cumulative 
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number of data points above each Threshold, and this number is dependent upon the 

Resolution value set on the Experiment Preferences screen.   

To stop a chamber before an experiment is complete, go to Experiment | Stop 

Chambers.  A screen similar to Figure 21 will be displayed. Select the chamber or 

chambers to stop.  Choosing OK will stop the selected chamber.  Cancel will return to 

the main Experiment screen without stopping any chambers.   

NOTE: Once a chamber is stopped during an experiment, it should not be restarted. 

Restarting a chamber will invalidate the raw data file.  To stop and then restart the 

chamber, choose the Pause option (see below). 

To pause a chamber that is currently running, go to Experiment | Pause Chambers.  

A screen similar to Figure 21 will be displayed, then select the chamber or chambers to 

pause.  Choosing Pause will pause the selected chamber, Cancel will return to the main 

Experiment screen without pausing any chambers.  When a chamber is paused, no data 

is acquired for the selected chamber and the clock is stopped.  When continue is chosen, 

the data are again acquired and the clock continues from where it had left off.  For 

example, if there were 4 chambers running for 5 minutes, pausing chamber one for 1 

minute would increase the total run time of the experiment to 6 minutes.  Chambers two 

through four would stop at the end of the fifth minute.  Chamber 1 would stop at the end 

of the sixth minute. 

To restart a paused chamber, go to Experiment | Resume Chambers.  A screen 

similar to Figure 21 will again be displayed, and select the chamber or chambers to 

continue.  Choosing Resume will allow the chambers to continue.  Cancel will return to 

the experiment runtime screen leaving the chambers paused.  

To display the runtime graph for several chambers simultaneously go Window | Tile.  
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CHAPTER 5  | USING TAIL SUSPENSION VIEWER 

To access the Tail Suspension Viewer utility, start the Tail Suspension program and go to 

View | View Raw Data (Figure 24). 

 

Figure 24 - Getting to the Tail Suspension Viewer Screen  

 

 

This will bring up a File Open dialog box.  Browse to the data file to open.  The raw data 

file will open in the Tail Suspension Viewer window. 

Opening a Fi le to View  

Once the Tail Suspension Viewer window is open, more raw data files may be opened by 

selecting  File | Open Data File.  A standard Windows open dialog box will be 

displayed, where the file to view may be chosen. 
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Menu Options  

The following options are available under the File menu. 

 Open Data File – Opens a Tail Suspension raw data file. 

 Close Data File – Closes a data file. 

 Print – Prints current screen. 

 Import – Imports previous versions of Tail Suspension data files. 

 Exit – Exits the program. 

The following options are available under the Controls menu. 

 Play – Scrolls forward through the data file. 

 Pause – Stops scrolling the data file. 

 Rewind – Scrolls backwards through the data file. 

 Fast Forward – Scrolls forward through the data file ten times faster than play. 

 Fast Reverse – Scrolls backwards through the data file ten times faster than rewind. 

 Beginning – Goes to the beginning of the data file. 

 End – Goes to the end of the data file. 

 Refresh – Refreshes the screen. 

The following options are available under the Options menu. 

 Colors – Modifies the color of the thresholds, tracking and data lines. 

 Current File – Selects the current file.  The program cannot scroll past the end of the 

current file. 

The following options are available under the View menu. 

 File Information – Displays information about the open files and allows recalculation of 

threshold parameters. 

 Zoom – Changes the scale of the data graph.  If the tracking bars would be moved off 

the screen due to modifying the scale, the tracking bars are moved to a location that is 

visible on the screen. 

 Tracking – Turns the Tracking Line (Trace 2) on and off. 

 Lock Trace 1 – Locks the Trace 1 position.  When locked, the Trace 1 position will not 

change unless manually moved.  Otherwise, the Trace 1 position will change as the file is 

viewed. 

 Lock Trace 2 – Locks the Trace 2 position. 

 View Text Summary File – Displays summary files. 

 View CSV Summary File – Displays CSV summary files. 

 View CSV Batch Summary File – Displays CSV batch summary files. 

 View CSV Raw Data File – Displays CSV raw data files. 

The following options are available under the Create menu. 

 Create Text Summary File – Creates a text summary file from a raw data file. 
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 Create CSV Summary File – Creates a CSV summary file from a raw data file. 

 Create CSV Batch Summary File – Creates a CSV batch summary file from a set of raw 

data files. 

 Create CSV Raw Data File – Creates a CSV raw data file from a raw data file. 

The Help menu displays program information and the Tail Suspension Viewer version number. 

 

Figure 25 - Viewer Screen 

 

 

The Trace 1 Line  

When a Tail Suspension data file is loaded, the status bar in the bottom of Figure 4.2 displays 

information about the trace 1 line (the vertical line that automatically appears on the viewer 

window) in the lower left.  The Current Time is the position of the Trace 1 line along the x-axis, 

and the Current Value the y-axis value at that x-axis position.  

To adjust the horizontal position of the Trace 1 line, move the mouse pointer over the line until 

the cursor changes from the standard windows pointer to a double arrow, then press and hold 

the left mouse button.  Drag the Trace 1 line to the desired position and release the mouse 

button. 
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Trace 2 Line (Tracking Line)  

Information about the Trace 2 line is shown in the lower right corner of the status bar.  When 

Tracking (a.k.a. Trace 2) line is enabled, the status bar also shows how far apart the two lines 

are.  In the above example, the Trace 2 line is 3 minutes, 18.5 seconds apart from Trace 1.  The 

Trace 2 lines position is 5 hours, 9 minutes, 47.5 seconds in the data file. 

Zoom 

To enlarge the size of the viewer graph, go to View | Zoom.  Select a zoom factor of 0.1, 0.2, 0.3, 

0.4, 0.5, 1, 2, 3, 4, 5, 6, 7, 8, 10, 15, & 20 times the normal scale.  To zoom the graph along the x-

axis, make sure View | Zoom | X-Axis is checked.  Note that when the zoom value is less than 1, 

View | Zoom | X-Axis is automatically checked. 

Viewing Multiple Chambers  

Once a raw data file is open in the Tail Suspension Viewer, view data from multiple chambers 

simultaneously by going to File | Open and select another data file to view. Two plots should 

show in the view window, and these will track together if Controls | Play is selected.   

It may be helpful to modify the colors of the lines to distinguish the results between subjects. Go 

to Options | Colors and select a data file. Choose a color to represent the selected data using 

the Color window, and press OK.   

Figure 26 - Data From Two Different Subjects  
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Replaying the Experiment  

Along the top of the screen are seven buttons used to control the display of data.  The 

following chart describes each button. 

 

 
Jumps to the beginning of a raw data file.  

 
Scrolls backward in time at a fast speed until stopped, or until the beginning of the file is 

reached. 

 
Scrolls backward in time at a normal speed until stopped, or until the beginning of the file is 

reached. 

 
Stops scrolling. 

 
Scrolls forward in time at a normal speed until stopped, or until the end of the experiment  is 

reached. 

 
Scrolls forward in time at a fast speed until stopped, or until the end of the experiment is 

reached. 

 
Jumps to the end of a raw data file. 

 
Displays the File Information screen. 

 
Displays the Tail Suspension Viewer About screen.  

Closing the Raw Data Fi le  

Files are closed automatically when exiting the viewer (File | Exit).  If multiple files are 

being viewed on the same graph, the File | Close Data File option will allow the user 

to select which data files to close. 
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CHAPTER 6  | VIEWING EXPERIMENT SUMMARY INFORMATION 

To view the experiment summary information, go to View | Summary File and select a 

data file. 

 

Figure 27 - Open Experiment Summary File Screen  

 

 

The summary data are automatically opened in Microsoft WordPad ®. The first row of 

the file lists the date and time on which the experiment was completed. Subject, session, 

and other identifying information are listed first, followed by the independent variables 

(e.g. experiment length and block time). 

The dependent variables are listed below in a section titled Summary Blocks.  The time 

above and below each threshold, the number of threshold crossings, and the sum above 

each threshold are listed for each block. Appendix B contains examples of several 

different data file formats, including the summary file format.  
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APPENDIX A | DIG-735  

DIG-735 DIP Switch Settings  

The DIG-735 card has a dipswitch labeled SW1 that is used to configure the card for the 

chamber that it controls. The cards are configured for the appropriate chamber prior to 

shipping; however, should the address of a card need to be changed, for example,  if an 

add-on unit is purchased, the settings shown in the table below should be used.  

To access this switch, turn off the power to the interface cabinet, and remove the DIG-

735 card from the interface cabinet.  A small screwdriver or ballpoint pen can be used to 

slide the toggle.  The toggle will be on when the red dot is moved toward the ON 

position.  Use the following table to set each DIG-735 card with the appropriate address 

that corresponds to the chamber number that the card controls.   

 

 

 

The Integration Switch  

This switch, located on the DIG-735 card sets the signal integration to be either on or off.  The 

signal integration is used to smooth the response signal.  For example, when the subject is 

struggling, the raw signal (integration off) will swing back and forth from zero.  This will cause 

many threshold crossing and increment the time below threshold, when the animal is not 

actually freezing.  With the integration on, the raw signal is integrated over time, so when the 

subject is struggling, the signal will stay high.  Only when the subject is truly not moving will the 

signal go to zero.  Experiment with this switch to see which setting work best. 
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The High-Pass Fi lter  

The DIG-735 features an adjustable high-pass filter that can be adjusted by turning the knob on 

the DIG-735 module.  This filter can be used for getting rid of low frequency artifacts and any DC 

drift from the load cell.  The default position for the switch is 1 Hz.  Experiment with this filter to 

see which settings work best. 
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APPENDIX B | DATA FILE FORMATS 

Summary Fi le  

Printed on : 05/20/2005 11:28:05 

                        Tail Suspension Summary, Version 3.2 

 

Experiment ID:  

Group ID     : Testing C57 compound XJ822 

Subject ID   : 1 

Subject Info : Weight - 25 grams 

Comment      : First test 

Session #    : 1 

 

Experiment Length        : 5 minutes 

Block Time               : 60 seconds 

Number of Blocks         : 5 

Experiment Date and Time : 05/20/2005 11:23:04 

 

Actual Run Time          : 0:05:00.000 

Resolution               : 10 milliseconds 

Upper Threshold          : 50.0 

Lower Threshold          : 20.0 

------------------Summary Blocks------------------ 

Block Number 1 

Time Below Lower Threshold : 0:00:34.260 

Time Above Lower Threshold : 0:00:07.020 

Time Above Upper Threshold : 0:00:18.720 

Lower Threshold Crossings  : 18 

Upper Threshold Crossings  : 12 

Sum Above Lower Threshold  : 24351.5 

Sum Above Upper Threshold  : 157338.9 

 

Block Number 2 

Time Below Lower Threshold : 0:00:34.280 

Time Above Lower Threshold : 0:00:07.000 

Time Above Upper Threshold : 0:00:18.720 

Lower Threshold Crossings  : 14 

Upper Threshold Crossings  : 12 

Sum Above Lower Threshold  : 24306.4 

Sum Above Upper Threshold  : 157311.7 

 

Block Number 3 

Time Below Lower Threshold : 0:00:34.980 

Time Above Lower Threshold : 0:00:06.640 

Time Above Upper Threshold : 0:00:18.380 

Lower Threshold Crossings  : 16 

Upper Threshold Crossings  : 12 

Sum Above Lower Threshold  : 23137.0 

Sum Above Upper Threshold  : 155006.3 

 

Block Number 4 

Time Below Lower Threshold : 0:00:34.960 

Time Above Lower Threshold : 0:00:06.960 

Time Above Upper Threshold : 0:00:18.080 

Lower Threshold Crossings  : 19 

Upper Threshold Crossings  : 12 

Sum Above Lower Threshold  : 24204.5 

Sum Above Upper Threshold  : 150987.0 

 

Block Number 5 

Time Below Lower Threshold : 0:00:35.240 

Time Above Lower Threshold : 0:00:06.620 

Time Above Upper Threshold : 0:00:18.140 

Lower Threshold Crossings  : 15 

Upper Threshold Crossings  : 11 

Sum Above Lower Threshold  : 23087.2 

Sum Above Upper Threshold  : 152691.7 
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CSV (Comma Separated Value) summary data fi les  

The CSV summary data files are the same as the summary file format shown above, except using 

commas as column separators for easy opening in a spreadsheet program. 

CSV (Comma Separated Value) batch summary fi les  

The CSV batch summary files created by Tail Suspension contain the summary data from 

multiple experiments in an easy to read format that is understood by most spreadsheet 

programs.  Following is part of a sample CSV file. 

 

Figure 28 - Sample CSV File 

 

CSV (Comma Separated Value) Fi les  

The CSV files created by Tail Suspension contain the raw data in a ready-to-import format that 

can be read by most spreadsheet programs.  Following is part of a sample CSV file. 

The first value in each row is the raw value. The raw value is the voltage read by the DIG-744 

(NI-DAQ card) at every time point (defined by Resolution) multiplied by 10, and the raw value is 

always between –100.000 and 100.000. 

0.195 

0.324 

1.113 

2.644 

2.257 

1.045 

 

APPENDIX C  | CONTACT INFORMATION 

Please contact MED Associates, Inc. for information regarding any of our products.   

Visit our website at www.med-associates.com for contact information. 

For technical questions, email support@med-associates.com. 

 

http://www.med-associates.com/contact.htm
../Internal/support@med-associates.com
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